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SOFTWARE LICENSE AGREEMENT 
 
CAP Analysis Ver. 4.0 (including the hardware key, CD, diskettes or other 
magnetic media, and documentation) are subject to the terms listed below. 
1. You may not copy or reproduce all or any part of the Product. 
2. You may make archival copies of the software files. 
3. No license is granted to the Licensee to sell, license, distribute, market 

or otherwise dispose of any software files or other component of the 
Product. 

4. The Product and the media on which the software files are provided are 
substantially free from significant defects in materials and 
workmanship under normal use for a period of twelve (12) months 
from the date of delivery of the Product to you. In the event of a claim 
under this warranty, the Product will be repaired or replaced free of 
charge. 

Warranty claims must be made in writing during the warranty period and 
within seven (7) days of the observation of the defect. Please contact the 
software developer (raffaele.ferri@tiscali.it) for further details. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Important notice: All attempts have been made to make the information in 
this document complete and accurate. The software developer is not 
responsible for any direct or indirect damages or loss of business resulting 
from inaccuracies or omissions. The specifications contained in this 
document are subject to change without notice. 
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Chapter 1 – Introduction to 
CAP Analysis Version 4.0 

 
 
CAP Analysis ver. 4.0 is a software which performs a series of calculations 
on data from files containing all the necessary information on sleep 
macrostructure and microstructure (Cyclic Alternating Pattern or CAP). 
 
This software was developed in order to be compatible with a series of 
different data files obtained by exporting the pertinent data from different 
commercial sleep recording and analysis systems. At present, files exported 
by the Somnologica© (Flaga hf. Medical Devices) and by the Rembrandt© 
systems can be read and analyzed. 
 
Depending on the type of license obtained, the program will automatically 
activate the appropriate features and will allow users to process files from 
one system or the other, or both. 
 
 

System Components 
 
The system consists of three components: 
 
• The hardware key, a programmable memory device providing the 

responses required to unlock the software. Without this key CAP 
Analysis ver. 4.0 does not run; please take care of the key as you will 
need to buy the whole system package again in case of loss or damage. 
Keys can be upgraded in order to transform the license type (see 
above).  

• The program installation CD with all the files you need to install and 
run CAP Analysis ver. 4.0; also this guide, in electronic format is 
included in the CD (you will need Adobe Acrobat Reader© v. 4.0 or 
above to read it; Adobe Acrobat Reader© is available, free of charge, 
on the internet http://www.adobe.com/acrobat). 

• This guide. 
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System Requirements 
 
CAP Analysis ver. 4.0 runs under Windows 95, 98, 2000, NT, Me and XP. 
No particular RAM size is required; it occupies approximately 8 Mb of disk 
space (software and documentation) and a screen resolution of at least 
800x600 pixel is recommended; however, also lower screen resolutions can 
be used. 
 
 

Installing the Software 
 
A Windows-based installation program is provided to facilitate installation 
of the CAP Analysis ver. 4.0 software on your hard disk. The installer 
creates all required directories and copies the files required. 
 
Note: Contents and installation procedures may change. Refer to the 

README.TXT file for up-to-date information. 
 
Running the Installer 
• Insert the CD into the CD-ROM drive. If autorun is enabled, the system 

will automatically position you at the Welcome screen; otherwise, 
execute INSTALL.EXE. 

• At the Welcome screen you can read a brief Introduction to CAP 
analysis. Also an electronic copy of the User Guide is available (PDF 
format). 

• To install the software, click on Install Software and follow the 
directions on the screen. You will be prompted for a destination path 
for the files. 

• Please make sure to install the hardware key driver for your system 
before running CAP Analysis ver. 4.0. Click on Install Key Driver to 
launch the appropriate driver, depending on your operating system and 
hardware platform. 
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Chapter 2 – Recording CAP Data 
 
 
 
Before you can run CAP Analysis ver. 4.0 you need to export CAP data 
from your sleep recording and analysis system. Most commercially 
available systems allow their users to define events and to export them in 
form of type, time, and duration. For CAP analysis, we need to define 3 
types of events, i.e. the CAP-A phase subtypes A1, A2, and A3 and to mark 
them with our sleep analysis software. We do not need to mark CAP-B 
phases because they are automatically calculated as the interval between 
two consecutive CAP-A phases in a CAP sequence. We then need to store 
the values of all consecutive CAP-A phases, along with those of the sleep 
macrostructure (hypnogram), in a .TXT file which can be read by CAP 
Analysis ver. 4.0. This chapter explains how to perform this process with 
two systems: Somnologica© (Flaga hf. Medical Devices) and Rembrandt©. 
 
 

Creating a Text File with the CAP Data from 
Somnologica© 
 
Defining CAP Events 
When you have your Somnologica© program running, click on Events, then 
Types; the following window will appear: 
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Click on New and define the Default label (A1, A2, and A3), the Type name 
should be the same as the Default label and assign a Hot-key (suggested: F1, 
F2, and F3). Repeat the same steps for the three A phase types. At the end 
of this operation, the Event Types window will appear like this: 
 
 
 

 
 
 
 
 
 
Marking CAP Events 
After loading a sleep file, you are ready to mark A1, A2 and A3 events. 
Note that you do not need to mark B phases because they are automatically 
detected by the CAP-Analysis software.  
 
Click on the preferred channel with the left mouse button and drag the 
pointer to the end of the event; then release the left button of the mouse. The 
marked event will appear as in the following figure: 
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When the event is selected, press the desired Hot-key (F1, F2, or F3) to 
assign the A phase subtype; the event will then appear like this: 
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Exporting CAP Events 
When you have selected all the events and the macrostructural sleep scoring 
has been performed, you can export all these events. Click the File menu, 
Export and Event Data Export. 
 
 
 

 
 
 
 
When the following window appears on the screen, select All Events in 
Event Palette window and add A1, A2, and A3 to the window Analyze. Then 
click OK. 
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Click the File menu again, followed by Export and Event Export. 
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Save the file with the extension .txt. 
 
At this point you can leave Somnologica© and run CAP Analysis ver. 4.0 
for the computation of all CAP parameters. 
 
 
 
Creating a Text File with the CAP Data from 
Rembrandt© 
 
Marking CAP Events 
When you have your Rembrandt© program displaying the Signal Window, 
select the Draw Event Mode on, then place it at the beginning of the epoch to 
mark, push the left mouse button down and move the cursor up to the end of 
the epoch to mark, then release the left mouse button; choose the User 
Events option from the popup menu and the following window will appear: 
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Type CAP in the Event Trace window and A1, A2, or A3 in the 
Classification window. You will need to type CAP in the Event Trace 
window only the first time, then you will select this type of user events for 
all your CAP events. You also need to type A1, A2, and A3 only once in the 
Classification window; you will only need to select the appropriate 
classification for the rest of your CAP events. 
 
In order to see the epochs you mark in the Signal Window, you need to 
modify it and to insert a new signal. First, right click with your mouse the 
left area of the Signal Window where all the channel labels are displayed and 
choose Signal Window Properties from the popup menu. The following 
window will appear: 
 

 
 
Select CAP, under User and click the Add button. A channel will be added at 
the bottom of your Signal Window and you can move this trace to the 
position you prefer. After this operation, your CAP events already marked 
will appear as follows: 
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Mark all CAP events before going to the next step. 
 
Note that you do not need to mark B phases because they are automatically 
detected by the CAP-Analysis software. 
 
 
 
Exporting CAP events 
When you have selected all the events and the macrostructural sleep scoring 
has been performed, you can export all these events. Click the Tools menu, 
and then Event Trace Tool. 
 
The Event Trace Tool window will appear: 
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In this window, select first Adult Stages/Adult Hypnogram (or Pediatric 
Stages/Pediatric Hypnogram) and then User/CAP, then click Export.  
 
Save the file with the extension .txt. 
 
At this point you can leave Rembrandt© and run CAP Analysis ver. 4.0 for 
the computation of all CAP parameters. 
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Warning 
 
Please note that it is mandatory to score the sleep macrostructure before the 
analysis of CAP; for this reason, it is necessary to have the sleep scored 
(automatically or visually) before exporting CAP data. On the contrary, the 
files exported will generate an error when loaded by CAP Analysis ver. 4.0. 
 
Moreover, CAP Analysis ver. 4.0 assumes a fixed sleep epoch length of 30 
seconds; the use of different sleep epoch lengths will cause the computation 
of inconsistent results. 
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Chapter 3 – Running CAP Analysis ver. 4.0 
 
 
 
 

Installing the Hardware Key 
 
CAP Analysis ver. 4.0 requires the hardware key, provided together with the 
other components of the package, to run. The hardware key has a 25-pin 
connector to be attached to a parallel printer port of your IBM-compatible 
computer. Tighten the screws to connect the key securely to the port. 
 
If a printer is connected to the computer, attach the printer cable to the 
outside connector of the key. 
 
Multiple key can be connected to the same parallel port. This is called 
“cascading”.  Make sure that the hardware key is the last key in the chain 
(farthest from the computer). 
 
If the computer is close to a wall or another obstacle, you can attach an 
extension cable to the port, then attach the hardware key to the cable. Use a 
straight-through DB-25 male-to-DB-25 female cable. 
 
 
 
 

Importing Text Files with CAP Data  
 
After the installation, run CAP Analysis ver. 4.0. From the File menu, 
choose to import the appropriate file generated by one of the commercial 
sleep analysis systems supported (Somnologica© or Rembrandt©).  
 
Please note that, if your hardware key allows you to import both data file 
types, you should pay attention to choose the File menu item appropriate for 
the system you used to generate the file (see Chapter 2); on the contrary, 
CAP Analysis ver. 4.0 will generate an error message. 
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Main Page 
 
Soon after loading the file, CAP Analysis ver. 4.0 displays the Main Page 
which appears as in the following example: 
 

 
 

This Page shows 3 graphs and one table. 
 
Hypnogram 
The top graph shows the hypnogram in a standard representation with the 
following sleep stages, in descending order: Wakefulness (green), REM 
sleep (red), and sleep stages 1, 2, 3 and 4 (black thin line). Movement 
epochs (MT) are shown as blue short segments at a level between 
Wakefulness and REM sleep. If you click on this graph you will be 
prompted for saving the corresponding bitmap (.BMP format). 
 
CAP-A Phase Subtype Occurrence Graph 
The second graph from the top shows the occurrence of each CAP-A phase. 
A1 subtype phases are shown in the top row (red); A2 phases are shown in 
the middle row (green) and, finally, A3 phases are displayed in the bottom 
row (blue). If you click on this graph you will be prompted for saving the 
corresponding bitmap (.BMP format). 
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Time Distribution Histogram of CAP 
The last graph (the fourth from the top) shows the distribution histogram of 
the number of CAP-A1 phases per 5-minute epoch, throughout the entire 
recording (white columns); also the number of the CAP A2+A3 phases is 
shown in the same epochs (black columns). The scale of this graph is shown 
on the left. After clicking this graph you will be prompted for saving the 
corresponding bitmap (.BMP format). 
 
CAP Analysis Table 
The bottom half of the main window is occupied by the Table reporting the 
results of the CAP analysis of the current file. A series of measures is listed 
which describes all important parameters of CAP: 
Total number of A (phases): 

during the whole recording and for each NREM sleep stage     
CAP Rate (time in min): 

CAP rate is defined as the percentage of time of NREM sleep (and of each 
stage) occupied by CAP sequences (see below for the definition of CAP 
sequences); also the CAP time is shown between brackets     

Total number of A1:     
during the whole recording (also the percentage of the total is shown 
between brackets) and for each NREM sleep stage (together with their 
rate/hour between brackets)    

Total number of A2:     
values shown as above     

Total number of A3:    
values shown as above     

A  mean duration:       
total CAP-A phase mean duration, during the whole recording and for 
each NREM sleep stage, in seconds     

A1 mean duration:       
values shown as above for CAP-A1 phase subtype; the last value of this 
line represents the number of CAP-A1 phases/hour of NREM sleep (A1 
index)    

A2 mean duration:       
values shown as above, for CAP-A2 phase subtype      

A3 mean duration:       
values shown as above, for CAP-A3 phase subtype    

B  mean duration:       
values shown as above, for CAP-B phase 

B  mean duration after:       
mean duration of CAP-B phases following each CAP-A phase subtype 

Cycle mean duration:      
values shown as above, for the entire CAP-A+B complex (cycle) 
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Isolated A phases: 
number of total CAP-A phases not in sequences, followed by the number 
(and percentage) of each CAP-A phase subtype not in sequences 

Sequences closed by: 
a sequence is formed by a series of CAP-A phases 2-60 seconds apart from 
each other; the sequence starts with the onset of its first CAP-A phase and 
stops at the beginning of its last CAP-A phase; in this line the number of 
sequences stopped (closed) by each CAP-A phase subtype is shown 

Sequence mean duration: 
in seconds 

Number of sequences    
Cycles/sequence:        

average number of CAP cycles per sequence 
A phases in sequence: 

percentage of total CAP-A phases in sequences 
A Ratio Index:      

A newly proposed index monitoring the ratio between A1 and A2-+A3 
CAP phase subtypes. A Ratio Index is calculated as follows: 
 
If A1>(A2+A3) then  

A ratio=A1/A total*(A2+A3) per minute  
Else if A1<(A2+A3) then  

A ratio=-(A2+A3)/A total*A1 per minute  
Else 

A1=(A2+A3) then A ratio=0 
 End if      

 
Pop-up Menu 
Clicking the CAP Analysis Table with the right mouse button causes the 
appearance of a Pop-up Menu with the following aspect and options: 

 
Copy Data: 
 to copy all the table values to the clipboard 
Copy Labels: 
 to copy all the data labels to the clipboard 
Save Text: 
 to save the table text to a .TXT file 
Cancel: 
 to exit this menu 
 
This menu allows users to easily pass the results of the analysis from CAP 
Analysis ver. 4.0 to the desired statistical application or spreadsheet 
program and then to perform, easily, the desired analysis of group statistics. 
The data labels are in the same order as the values. 
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Stats Pages 
 
When your file is loaded and the Main Page reports all the analysis detailed 
above, the Stats Pages become active and can be displayed by clicking their 
label at the bottom. These windows show some more detailed analysis of 
the time structure of the CAP-A phase occurrence by means of different 
statistical approaches. 
 
Total A Stats 
The first Stats Page reports the detailed analysis of the time structure of the 
occurrence of all CAP-A phase subtypes. The following figure shows an 
example of this window. 
 

 
 
The left graph shows the distribution histogram of the number of intervals 
between consecutive CAP-A phases, subdivided into 5-second classes 
(blue), plotted against the log-normal distribution with the same mean 
(green). The cumulative function is shown in red. The scale on the left 
reflects the raw number, for the distribution functions, and the percentage of 
the total, for the cumulative function. 
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The button labelled Save Lags allows the user to save a .TXT file with the 
sequence of all lags between the consecutive CAP-A phases; the button 
labelled Save Classes allows the user to save a .TXT file with the values of 
the distribution histogram. 
 
The middle text window is labelled Statistics and shows the statistical 
analysis of some important features of the lags between all consecutive 
CAP-A phases: 
Total No.: 

total number of  lags 
Mean: 

mean lag length (in seconds) 
Median: 

median lag length (in seconds) 
Mode: 

mode lag length (in seconds) 
Max Class: 

lag class with the highest value in the distribution histogram (in seconds) 
Min: 

shortest lag length (in seconds) 
Max: 

longest lag length (in seconds) 
SD from Norm: 

standard deviation of the observed distribution from the log-normal 
distribution 

 
The last text window on the right shows the analysis of the time structure of 
the CAP-A phase occurrence by mean of the model of Markov chains. First 
the entropy of the zero-memory model (H0) is calculated and then that on 
the first-order Markov process model (H1). The Nakahama index is 
calculated as follows: 

Nakahama index = (H0-H1)/H0 
Please note that if the total number of lags being analyzed is less than 100, 
the results of the Markov process analysis can be inconsistent. 
 
 
A1 Stats 
The A1 Stats Page reports the detailed analysis of the time structure of the 
occurrence of all CAP-A1 phase subtypes. This page has the same structure 
as that described above. 
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A2+A3 Stats 
The A2+A3 Stats Page reports the detailed analysis of the time structure of 
the occurrence of all CAP-A2 and CAP-A3 phase subtypes. Also this page 
has the same structure as that described above for all CAP-A phases. 
 
 
 

Macro/Micro Page 
 
 
The Macro/Micro page contains two graphs and one table and appears as 
shown below: 
 

 
 
Macro/Micro Hypnogram 
The graph on the top shows the classical hypnogram with the sleep 
macrostructure and the addition of thin vertical bars indicating the 
occurrence of each CAP-A phase subtype (A1 in red, A2 in green, and A3 
in blue). The green bar at the bottom of this graph indicates the section 
which is enlarged in the second graph of this page and can be shifted by 
means of the tool between the two graphs. 
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Enlarged Macro/Micro Hypnogram 
This graph shows a section of two hours of the graph described above, 
corresponding to the position of the green bar. In this graph, the details of 
the correlation between sleep macrostructure and microstructure can be 
seen. The thick brown bars at the bottom of this graph show the extension 
of the different CAP sequences identified by CAP Analysis ver. 4.0. 
 
Sleep Scoring Table 
At the bottom of the Macro/Micro page a table reports all the main sleep 
macrostructure parameters: 
 
TIB: 

time in bed, in minutes 
SPT: 

sleep period time, from sleep onset to sleep end, in minutes 
TST: 

total sleep time, SPT-wakefulness after sleep onset, in minutes 
SOL: 

sleep onset latency, from recording start to sleep onset, in minutes 
FRL: 

first REM latency, from sleep onset to the occurrence of the first REM 
period, in minutes 

Stage shifts/h: 
number of sleep stage shifts after sleep onset per hour 

Awakenings/h: 
number of awakenings after sleep onset per hour 

Movements/h: 
number of sleep epochs classified as MT after sleep onset per hour 

Sleep efficiency%: 
TST / TIB × 100 

No. of REM periods 
number of REM periods 

WASO: 
wakefulness after sleep onset,  minutes and percentage of SPT 

S1, S2, S3, S4, SWS, REM: 
sleep stages 1, 2, 3, 4, 3+4 (SWS), and REM after sleep onset,  minutes 
and percentage of SPT and of TST 
 
 

Pop-up Menu 
Clicking the Sleep Scoring Table with the right mouse button causes the 
appearance of a Pop-up Menu with aspect and options similar to those 
already described for the CAP Analysis Table (see page 15). 
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Menus 
 
 
CAP Analysis ver. 4.0 has four main menus with the functions listed below. 
 
 
 
File Menu 
This menu should be clicked for the following functions: 
• Import CAP data files (.TXT format) 
• Printer Setup 
• Print Form and Print Screen 

both these functions allow to print a copy of the entire screen; try 
both functions and use the best for you needs 

• Save Form BMP 
with this function it is possible to save a bitmap of the current 
screen and to use it in graphical applications 

• Exit 
to end the CAP Analysis ver. 4.0 session. 

 
 
 
Help Menu 
This menu allows the user to access online help on the following topics: 
• Importing CAP data files (.TXT format) from the supported sleep 

recording and analysis systems 
• A brief Introduction to the basic information on CAP analysis 
• Using the CAP Analysis ver. 4.0 software. 
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Hardware Key Menu 
This menu allows the user to read the Hardware Key Serial Number (SN) 
and the type of Licence (Somnologica, Rembrandt, or Full). 
 

 
 
Please note that this information is needed for all requests on your CAP 
Analysis ver. 4.0 software. 
 
 
? Menu 
This menu allows the user to display information on the program version 
and copyright. 
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